“Capacity Building and Strengthening Institutional Arrangement”

Subcomponent Awareness Building

Presentation of available tools to design and to develop an e-learning system for environmental education and training

Mrs. Daniela Antonietti

APAT

Agency for Environmental Protection and Technical Service

Service for the Environmental Education and Capacity Building
Index

1. Environmental e-learning
2. Environmental e-learning design
3. APAT Experiences on Environmental e-learning
4. APAT Environmental e-learning system
5. APAT activities on environmental e-learning
6. Introduction to HTML Editor
7. Working-group presentation
8. References
1. Environmental e-learning (I)

New technological tools can be applied to develop and implement knowledge on environmental issues and to promote ecological behaviour by means of information, education and training tools for young and adult people.

In fact, adult age is no more considered as a point of arrival of an individual acknowledgement, but as a period of continuous development of experiences, skills and competencies.
1. Environmental e-learning (II)

Within new technological tools, environmental distance learning is a didactical methodology based on the disjunction between learner and teacher in which training materials can be provided through Internet.

The distance learning is a flexible, dynamic and networking way of learning, according to the user’s features and easily time available. It is a powerful tool for people living in different Countries which have the same environmental knowledge needs.
1. Environmental e-learning (III)

The trainees can study didactical documents without any bond of time, in a compatible way with their main activities (asynchronous didactical activities), or can participate to a collaborative learning, through interactions between trainees, teachers, tutor in the same time, but without any bond of space (synchronous didactical activities).

Therefore, the distance learning represents a creative and innovative tool to develop environmental awareness and to promote scientific and technical knowledge, according to user’s requirements and availability.
1. Environmental e-learning (IV)

An important objective of the distance learning through Internet is the creation of relationships between participants and between participants and professional world of experts.

It is possible, in fact, to promote virtual training forum in which users can exchange experiences, best practices, case-studies or can compare with environmental experts in relation to specific issues on environmental protection.
1. Environmental e-learning (V)

To promote the development of professional figures in the field of environmental protection, these new didactical methodologies allow continuous training processes for experts involved in the field of environmental protection, sharing knowledge and experiences.

Environmental e-learning, therefore, is an effective alternative to the traditional training (indoor and outdoor), in order to answer to the enhancing needs of environmental protection training and awareness.
1. Environmental e-learning (VI)

Environmental e-learning can also be considered as an useful tool to diffuse environmental information based on technical and scientific data, in order to enhance and to improve environmental awareness and to promote more ecological behaviours, at international, national and local level.

E-learning, in fact, allows to reach all citizens easily, spreading environmental information and supporting local authorities for a more suitable environmental, economic and social management of the local territory with a lowest cost for each person reached.
1. Environmental e-learning (VII)

So, the main advantages of environmental e-learning are the follows:

- Continuous training
- Flexibility
- Diffusion of environmental knowledge on large scale
- Efficacy
- Unit cost reduction
1. Background analysis

2. Environmental e-learning design (I)

- Survey on the main web sites for environmental e-learning at national and international levels
- Analysis of the contents and the structural aspects of the most interesting environmental e-learning web sites
- General analysis of the state of the art of environmental e-learning, particularly at national level
- Definition of a common approach for environmental e-learning and preliminary consideration to develop an environmental e-learning system

Mrs. Daniela Antonietti
2. Environmental e-learning design (II)

Definition of the general training objectives

Definition of the target

- Environmental tecnicians
- Students
- Others
2. Environmental e-learning design (II)

- Definition of the general training objectives
- Definition of the target
- Designing of the general structure of e-learning platform

2. Definition of an Evaluation study

- Training courses
- Virtual secretary for trainees
- Tutoring activities for courses
- ...Other e-learning initiatives
2. Environmental e-learning design(II)

- Definition of the general training objectives
- Definition of the target
- Designing of the general structure of e-learning platform
- Analysis of the hardware requirements (for developers and users)
- Analysis of the software requirements (for developers and users)
- Costs forecast of the project development
- Time requirements to develop project
2. Environmental e-learning design (III)

- Designing of the general organization of training contents
  - Training modules
  - Training units

3. Carrying out of a prototype version

Mrs. Daniela Antonietti
2. Environmental e-learning design(III)

- Designing of the general organization of training contents
- Definition of didactical tools
  - Download
  - Bibliography
  - Glossary
  - Links

3. Carrying out of a prototype version
2. Environmental e-learning design (III)

- Designing of the general organization of training contents
- Definition of didactical tools
- Definition of community tools

3. Carrying out of a prototype version

Contacts
News
Forum
Chat
2. Environmental e-learning design(III)

- Designing of the general organization of training contents
- Definition of didactical tools
- Definition of community tools
- Carrying out of Internet pages for environmental e-learning prototype
- Using programmes for HTML editor or other languages

3. Carrying out of a prototype version
2. Environmental e-learning design (III)

- Designing of the general organization of training contents
- Definition of didactical tools
- Definition of community tools
- Carring out of Internet pages for environmental e-learning prototype
- Publication of environmental e-learning pages on preposed Internet web site
- Monitoring and assessment of the functionality of the e-learning prototype

3. Carrying out of a prototype version
2. Environmental e-learning design (IV)

- Development of the e-learning system platform (hardware and software aspects)
- Organisation of working activities to manage an environmental e-learning system

4. Carrying out of the environmental e-learning system

- Back-office
  - Hardware management
  - Software management
- Front-office
  - Trainees
    - secretary
  - Development and management of courses
  - Tutoring

Mrs. Daniela Antonietti
2. Environmental e-learning design (IV)

- Development of the e-learning system platform (hardware and software aspects)
- Organisation of working activities to manage an environmental e-learning system
- Assessment and monitoring of the correct functionality of the environmental e-learning system
- Check of the correspondence to accessibility and usability international standards

That is
Usability indicates the effectiveness of tool to accomplish users’ tasks in the best way possible.

Therefore, an usable e-learning site meets the users’ training requirements, allows an high level of scientific contents comprehension and allows an easy utilise of all didactical tools predisposed, in order to make easy and effective training activity.

To achieve an high level of usability it is important to focus on the end-users of the system and what training tasks they must accomplish.

For more information and guidelines you can consult the web site http://usability.gov/
Accessibility

2. Environmental e-learning design (VI)

Accessibility means that people with disabilities affecting access to the web (visual, auditory, physical, speech, cognitive and neurological disabilities) can use internet website understanding, navigating and interacting with the web. Moreover accessibility also benefits people using a slow internet connection.

Also for e-learning web system many accessibility features are easily implemented if they are planned from the beginning of the system development.

For detailed information and guidelines you can consult the website:

http://www.w3.org/WAI/
3. APAT experiences on environmental e-learning (I)

The participation into two European Project has allowed the ‘Service for the Promotion of Environmental Capacity Building’ to know the e-learning’s potentiality to diffuse on large scale the environmental competencies on environmental protection field.

✓ The project “Skills and competencies for local Agenda 21”, within the E. U. Leonardo da Vinci programme

✓ The project “Cooperation and Standard for Life Cycle Assessment” (CASCADE)” within the E.U. “Competitive and sustainable growth programme”.

These projects are examples of the recent efforts, carried out at European level, to develop and to diffuse useful training courses, through e-learning, to support changes taking place in markets and people behaviours, that should be taken into account by decision makers at national and local level for a more suitable environmental management.
3. APAT experiences on environmental e-learning (II)

Moreover, the “Service for the Promotion of Environmental Capacity Building” of APAT has developed a survey on the main web sites which provide environmental distance learning services, trying to define a ‘state of the art’ of environmental e-learning and to highlight a possible common approach in this field.

Then, APAT has performed an evaluation study for an environmental learning system, designed to promote specific skills and scientific and technical competencies and also to answer to the continuous needs of knowledge on the field of environmental protection.
4. APAT Environmental e-learning System (I)

Therefore the environmental distance learning system of APAT is composed by 2 main areas:

1. **Informative environmental e-learning**: oriented to spread environmental information on a large scale

2. **Vocational environmental e-learning**: for experts facing environmental problems, in order to develop scientific and technical knowledge both in institutional and professional areas

Therefore the e-learning system homepage reproduces this subdivision and introduces users, also, to other educational and training activities and tools.
4. APAT Environmental e-learning System (II)

Environmental Distance Learning
4. APAT Environmental e-learning System (III)

This section contains technical and scientific themes subdivided into topics dealing with different environmental issues, available for all citizens who want to increase their environmental knowledge.

This section is a virtual classroom, in which it is possible to attend different vocational courses, to ask questions to experts who work in environmental sectors, and to deepen knowledge and tools applicable to specific environmental protection activities.
4. APAT Environmental e-learning System (IV)

Kid’s Corner is finalized to spread environmental awareness and scientific information to young people.

The Small Municipalities Project is focused to spread environmental information and tools to promote environmental awareness and to share environmental data at local level.

In this section there are available tools to assess and to rise citizens’ environmental awareness, in order to promote more environmental friendly behaviours.
4. APAT Environmental e-learning System (V)

Didactical and informative contents of the environmental distance learning of APAT are organized into 8 thematic areas:

- **Air:** Climatic characteristics, qualitative aspects, pollution caused by the main substances (gasses and powders), acoustic emissions.

- **Water:** Physical – chemical – bacteriological characteristics of superficial and underground waters, water resources and consumption assessment, bathing waters quality.

- **Soil:** Soil use and destination, geological hazards analysis, soil’s physical – chemical quality, and pollution level caused by chemical products used in agriculture.

- **Nature and Biodiversity:** Habitats’ Natural level, protected natural areas and biodiversity assessment, ecosystems’ hazards and criticalities.
4. APAT Environmental e-learning System (VI)

Waste and pollutant substances: Wastes’ quantitative and qualitative evaluation, contaminated sites, waste management methodologies (collection, treatment, disposal) pollutant substances and pollution level per environmental thematic areas (air, water, soil, etc.) analysis of critical points and hazard level.

Energy and Radiation: Sources, productions and consumptions assessment.

Demography and Economy: Demographical aspects and quality mobility analysis, tourism, forest, agricultural, zoo-technical and ichthyic resources, landscape, archaeological, historical and cultural goods evaluation.

Environmental Culture and Sustainable Development: Available services, museums and centres, territorial associations, plans of sustainable development, adoption of European or national protocols.
5. APAT activities on environmental e-learning (I)

A prototype version of the Environmental e-learning system of APAT has been developed since January 2004 to support the environmental training courses promoted by the ‘Service for the Promotion of Environmental Capacity Building, through the ‘blended learning’ methodology which joins training activities carried out in presence with on-line didactical activities.
5. APAT activities on environmental e-learning (II)

Therefore, the main objectives of the APAT prototype environmental e-learning are:

- The training continuity during the development of the different scientific and technical modules (indoor and outdoor).
- The availability of the didactical training documents without any bond of space and time.
- The possibility to consult an annotated bibliography on specific environmental themes and a thematic list of web sites.
- The promotion of virtual communities through the development of training networks on specific environmental issues.
5. APAT activities on environmental e-learning (III)

The on-line training courses are organised in different self standing training modules composed by specific learning units, which made available immediately the scientific and technical contents of the frontal training activities and offer some further didactical tools to support trainees, such as:
5. APAT activities on environmental e-learning (IV)

- **Tools**
  - Download of scientific and technical documents

- **Download**
  - Annotated bibliography of reference

- **Bibliography**
  - Glossary of technical terms

- **Links**
  - Links to web sites of interest

- **News**
  - News and information about course activities

- **Contacts**
  - E-mail addresses to contact tutors
5. APAT activities on environmental e-learning (V)

This prototype version has required a low investment of economic resources because it has been carried out completely inside APAT working activities, using widely diffused and low cost software codes; particularly, the software used for HTML editor and for digital images management.

Through the development of this prototype some internal skills and competencies on web pages building and on management of innovative tools have been developed, aimed to elaborate and create new environmental informative and didactical instruments, also adaptable to the up-to date training needs.
5. APAT activities on environmental e-learning (VI)

The on-line training courses, developed up today, are available through the internet site of APAT, in the web page dedicated to the ‘Environmental Capacity Building’ activities
5. APAT activities on environmental e-learning (VII)

“Conservation of the biodiversity in the renaturalization and environmental restore”

The objective of this course is to give specific know-how in the field of biodiversity restoration and the competences regarding the methodologies and their application and also, to share experiences in this field through comparisons of different environmental situations: the Mediterranean environment and the Alpine environment. The course is composed by 4 training modules and is available at the URL: http://www.apat.gov.it/html/CorsoBiodiversita
5. APAT activities on environmental e-learning (VIII)

“Geostatistics applied to the environmental problems”

The course aims to deepen the Geostatistic methods applied to the environmental problems and is organized in order to teach both theoretical and practical aspects. Particular attention is given to the methods of geo-statistic analysis finalized to the characterization, modelling and estimate of spatial phenomena and their uncertainty to define tools and systems for environmental management. Training contents developed by Italian and French trainers, experts in different scientific sectors related to geostatistic are organised in 5 modules. The course is available at the all’URL: [http://www.apat.gov.it/html/Corso Geostatistica](http://www.apat.gov.it/html/Corso Geostatistica).
5. APAT activities on environmental e-learning (IX)

“Experts in analysis and evaluation in environmental impact assessment”

The course foresees the analysis of general EIA standards, the explanation of tools and methodologies used to prepare the different parts of an environmental impact study. The last part of the course is dedicated to the presentation of the national and regional standards with reference to wind energy plants with case-study exercises. The course is composed by 3 modules and is available at the URL: http://www.apat.gov.it/html/Corso VIA_VAS
5. APAT activities on environmental e-learning (X)

“Ecodesign, methodologies and tool for innovation and improvement of productive cycles”

The methodologies of analysis of productive cycles deal with impacts on the environment due to the productive processes. The aim of the course is the study of the following three macro-areas: eco-planning, environmental analysis of the productive cycles and management of the productive systems. The training contents are deepened through case studies and are available at the URL: http://www.apat.gov.it/html/Corso_Cicliproduttivi
5. APAT activities on environmental e-learning (XI)

“Genetically Modified Organisms”

Aim of the course is the updating on control and monitoring activities on voluntary release of genetically modified organisms. Training contents deepen the agronomical, biological aspects, also dealing with the legislative and environmental impact evaluation issues. The training contents are supported by different case studies and are available at the URL: http://www.apat.gov.it/html/Corso_OGM.
5. APAT activities on environmental e-learning (XII)

“Polluter transportation in ground and underground: physical behaviour and modelling to analyse the motion and dispersion”

The course is finalised to make available specific knowledge and tools needed to deal with modelling development of polluter transportation in ground and underground.

The training course composed by 4 modules is available at the URL: http://www.apat.gov.it/html/corso_contaminanti/
6. Introduction to HTML editor (I)

HTML is an acronym for Hyper Text Markup Language, the authoring language used to create documents on the World Wide Web. HTML defines the structure and layout of Web documents by using a variety of tags (a command that specifies how the document, or a portion of the document, should be formatted) and attributes. Software for HTML editor are programs that allow to create and design web pages without having to know HTML as easily as writing a page using a word processor.

Therefore a web site is a storage for web pages created...
6. Introduction to HTML editor (II)

To make some examples on the creation of HTML pages and an environmental web site we can use a commonly used software as Dreamweaver.

Preliminary steps:

1. Create a folder for the new web site on local machine and choose the site name

2. The folder have to contain all files that will be published on the environmental site which can be of different kind, as: html files, image files (eg: jpg, gif, etc), video files (eg: avi, mpg), audio files (eg: waw)
6. Introduction to HTML editor (III)

To create a new web page

Open up a new web page going to the File Menu and choosing New
6. Introduction to HTML editor (IV)

- Select a color for the background of the web pages or instead insert an image, choosing a file saved in the web folder
- Choose the text color and font
- Choose the color and modality for links

Save the file selecting File > Save
6. Introduction to HTML editor (V)

Entering and formatting text is similar to using text in a word processor.

From the **Property Inspector** it is possible to choose
- Text characteristics (font, style, color, size)
- Paragraph characteristics (align text, indent or outdent text)
- Lists (bulleted and numbered)
Tables are powerful tool used in web design to display data in an organized manner.

There are three basic components to a table: rows, columns and cells.

To insert a table:
• Place the cursor where you want the table to appear
• Click on the Table button on the Object Palette, or choose Insert> Table
• Set table in the dialog box to choose: number of rows and columns; cell padding, cell space, width of the table, border size (0 if without border)
To add text, images, or other elements to a table, click inside the cell in which you want to add something, and type text, paste a copied text, or insert images.
To insert an image:
- Select an image from the Insert menu or click on the Image bottom on the Object palette.
- From the dialog box, find the image, then click Open.
- Alter the size of the image by clicking on it and manipulating the handles.
- Align and set border from the Property inspector.

It is a good habit to designate an alternative text for images, for more accessibility of the site. You can insert the alternative text from the Property inspector.
6. Introduction to HTML editor (IX)

There are four types of links which are possible to create in an HTML pages:

- **Internal links**: Link to other pages in the same web site
- **External links**: Link to documents outside the web site
- **E-mail links**: Open an e-mail form
- **Named anchor links**: Jump to specific places within one document
6. Introduction to HTML editor (X)

To create an internal or external link:
• Type the text or insert the image which have to be linked and select it
• On the Property Inspector insert the name file linked (if internal link) or the URL (if external Link)

To create an e-mail link:
• Select the text
• Choose Insert > E-mail or click on the E-mail Link button

Some examples:

my@mail
6. Introduction to HTML editor (XI)

Finally to have a preview of the HTML file in an internet site choose the button of Preview.
7. Working-group presentation

This part of the module is finalised to introduce the participants, to the technical aspects of building-up an environmental e-learning site. Participants, subdivide into groups will be involved in different activities:

- Structural analysis of some environmental web sites and e-learning sites highlighting technical contents, and graphical aspects
- Introduction to activities to design some web pages for environmental e-learning
- Building up of some web pages for the e-learning site using images and contents for a web site